ABSTRACT

This document covers the usage and capabilities of the Scalable PMIC’s graphical user interface (GUI) tool from Texas Instruments. This GUI is intended to be used with the analog EVM Control (AEVM) in order to evaluate and configure the TPS6594-Q1 and LP8764-Q1 family of devices.

Table of Contents

1 Introduction ............................................................................................................................ 3
2 Supported Features .................................................................................................................. 3
3 Revisions ................................................................................................................................ 3
4 Overview .................................................................................................................................. 4
5 Getting Started ........................................................................................................................ 5
6 Quick-start Page ....................................................................................................................... 11
7 Register Map Page .................................................................................................................. 20
8 NVM Configuration Page ....................................................................................................... 21
9 NVM Validation Page .............................................................................................................. 49
10 Watchdog Page ...................................................................................................................... 51
11 Additional Resources ........................................................................................................... 56
12 Appendix A: Troubleshooting ............................................................................................... 56
13 Appendix B: Advanced Topics .............................................................................................. 58
14 Appendix C: Known Limitations .......................................................................................... 60
Revision History ....................................................................................................................... 60

List of Figures

Figure 4-1. GUI Overview ........................................................................................................ 4
Figure 5-1. GUI Composer Gallery ......................................................................................... 5
Figure 5-2. Locating the PMIC GUI in the Gallery .................................................................. 6
Figure 5-3. GUI Software Download Options ......................................................................... 6
Figure 5-4. GUI Panel Within the Gallery ............................................................................... 7
Figure 5-5. PMIC GUI Desktop Application ........................................................................... 7
Figure 5-6. Device Home Page ............................................................................................... 8
Figure 5-7. Device Settings From Options Tab ........................................................................ 9
Figure 5-8. Device Interface Settings ................................................................................... 9
Figure 5-9. Device Settings Bar ............................................................................................ 10
Figure 6-1. Quick-start Scan Page ......................................................................................... 11
Figure 6-2. Quick-start Scan Page Results .......................................................................... 12
Figure 6-3. Quick-start Page Highlights .............................................................................. 13
Figure 6-4. System Information ............................................................................................ 14
Figure 6-5. BUCK Configuration ......................................................................................... 15
Figure 6-6. LDO Configuration ........................................................................................... 16
Figure 6-7. GPIO Configuration ......................................................................................... 17
Figure 6-8. Interrupt Mask and Status ................................................................................ 18
Figure 6-9. Miscellaneous Settings ..................................................................................... 19
Figure 7-1. Register Map ....................................................................................................... 20
Figure 8-1. Open an Existing Configuration ........................................................................ 21
Figure 8-2. Starting from a blank template ......................................................................... 22
Figure 8-3. Configuration Development Flow ....................................................................... 23
Figure 8-4. BUCK Static Configuration .............................................................................. 24
Figure 8-5. Static Configuration, Failed Verification ............................................................ 24
Figure 8-6. Static Configuration, Passing Verification .......................................................... 25
Figure 8-7. Function Safety Assumptions Check ................................................................. 25
Figure 8-8. Example of non-updated Static Configuration Values.................................................................26
Figure 8-9. Save Often....................................................................................................................................26
Figure 8-10. PFSM Starting Templates...........................................................................................................27
Figure 8-11. PFSM Configuration.....................................................................................................................28
Figure 8-12. PFSM State Diagram Panel..........................................................................................................29
Figure 8-13. Complete State Diagram..............................................................................................................30
Figure 8-14. Global Settings...............................................................................................................................30
Figure 8-15. How to add a Power Sequence ......................................................................................................32
Figure 8-16. Power Sequence Command Window............................................................................................32
Figure 8-17. WAIT Command Action...............................................................................................................36
Figure 8-18. Empty Sub-Sequence.....................................................................................................................37
Figure 8-19. Power Sequence Tools..................................................................................................................38
Figure 8-20. Exported Sequence with Variable Conditions...............................................................................38
Figure 8-21. Trigger: STANDBY to SAFE.........................................................................................................39
Figure 8-22. Trigger: STANDBY to SAFE (continued).......................................................................................40
Figure 8-23. Trigger: SAFE to SAFE_RECOVERY..........................................................................................41
Figure 8-24. Mapping a Sequence to a Trigger...................................................................................................41
Figure 8-25. Completed Trigger Settings..........................................................................................................42
Figure 8-26. Trigger Priority List.......................................................................................................................43
Figure 8-27. PFSM Validation Results................................................................................................................43
Figure 8-28. NVM Programming........................................................................................................................44
Figure 8-29. Skip to Programming with an existing NVM Configuration............................................................45
Figure 8-30. Program with an Existing Configuration.......................................................................................46
Figure 8-31. Interface Change during Programming........................................................................................47
Figure 8-32. NVM Lock Option..........................................................................................................................48
Figure 9-1. NVM Validation...............................................................................................................................49
Figure 10-1. Watchdog Page...............................................................................................................................51
Figure 10-2. Watchdog Trigger Mode...............................................................................................................52
Figure 10-3. Invalid Trigger Watchdog Input.....................................................................................................53
Figure 10-4. Watchdog Q&A.............................................................................................................................54
Figure 10-5. Watchdog Q&A Valid Response......................................................................................................54
Figure 10-6. Watchdog Q&A Invalid Response..................................................................................................55
Figure 12-1. Hardware Platform Error.............................................................................................................56
Figure 12-2. PMIC Communication Error.........................................................................................................57
Figure 13-1. Default Scripting Window.............................................................................................................58
Figure 13-2. Scripting, Recording Register Read and Writes..............................................................................58
Figure 13-3. Scripting, Running a recorded sequence......................................................................................59

Trademarks
SimpleLink™ and Launchpad™ are trademarks of Texas Instruments.
Chrome™ are trademarks of Google.
Firefox™ is a trademark of The Mozilla Foundation.
Microsoft Windows,® is a registered trademark of Microsoft Corporation.
Linux® is a registered trademark of Linus Torvalds.
All trademarks are the property of their respective owners.
1 Introduction

This tool is based upon GUI Composer and requires the MSP432E401Y SimpleLink™ Ethernet Microcontroller as the analog EVM controller (AEVM), which is integrated in the PMIC EVM and also available with the Launchpad™, see 1 in the Section 11. The AEVM provides a USB interface to the host personal computer (PC) for receiving commands and then communicates with the PMIC using either an I²C or SPI protocol.

The GUI supports multiple devices with a single executable (and single AEVM), which eliminates the need to install multiple GUIs when working with more than one device. Multiple devices are configured in a master slave configuration and the AEVM communicates to each device over the selected shared medium: I²C or SPI.

2 Supported Features

The GUI supports the following features:

- Interface Multiple PMIC devices with a single GUI
- Quick-start and Register views to read and write to PMIC registers after power up
- Status Indicators for Interrupts and GPIO states
- Programming and Validation of non-volatile memory (NVM)
- Watchdog configuration and evaluation
- Multiple platforms ¹: Microsoft Windows®, Linux® 32 and 64-bit, and Mac OSX
- Web based and standalone versions available
- Links to additional collateral, support forums, and FAQ

3 Revisions

This section details the features added with each release of the Scalable PMIC's GUI.

Release 1.0.0 is the initial pre-production release and named the Programmable Processor PMIC's GUI. This version of the tool allows for evaluation and programming but does not provide a mechanism to create NVM configurations.

Release 2.0.0 is the latest release and named the Scalable PMIC's GUI. This document reflects this latest version.

Table 3-1. GUI Revisions

<table>
<thead>
<tr>
<th>Revision</th>
<th>Release Date</th>
<th>Devices Supported</th>
<th>Feature Updates and Additions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0.0</td>
<td>December 2019</td>
<td>TPS6594-Q1 Revision 1.0 Silicon</td>
<td>Initial Pre-Production Release</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Quick-start Page</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Register Map Page</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• NVM Programming</td>
</tr>
<tr>
<td>2.0.0</td>
<td>November 2020</td>
<td>TPS6594-Q1, LP8764-Q1, TPS6593-Q1, TPS6594-Q1 Revision 1.0 Silicon</td>
<td>• NVM Creation and validation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• NVM Templates</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Scripting</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• LP8764-Q1 Device Support</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Improved programming speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Watchdog Evaluation Page</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• SPI and CRC enabled serial communication</td>
</tr>
</tbody>
</table>

¹ Please refer to dev.ti.com for version compatibility with GUI Composer.
4 Overview

The GUI provides pages to both evaluate and configure the PMIC. For evaluation, the quick start, register map, and watchdog pages provide an interface to monitor and control the PMIC via a SPI or I²C interface. Configuration of the PMIC NVM is done through the NVM Configuration page and the NVM validation page is provided to read the NVM content of the PMIC. More information on the Quick-start, Register Map, NVM Configuration, NVM Validation, and Watchdog Evaluation pages will be provided in the subsequent sections.

The GUI also provides templates and references to the user guides and data sheets in order to assist in the development process. It is recommended, when applicable, to use an existing template as a starting point for development. These templates not only provide a graphical representation of the PMIC operation but also generate the required NVM files to program the PMIC.

Note

Starting from a template is recommended.

Device Selection

The Device Selection page is the first page presented when the GUI is started. From this page a specific device can be selected by selecting the Register Map within a given device window. The other pages can also be selected without regard of a particular device. From these pages it is necessary to use the Device Interface Settings window to select which device as well as the interface.

Register Map

The Register Map page is a list view of the available user registers with the ability to read and write to those registers.

Quick-start

The Quick-start page is recommended as the starting point for evaluating the device. The Quick-start page provides a graphical view for interacting with the PMIC and configuring the device registers. In addition to this abstracted view is the actual register view provided from the Register Map Page.
NVM Configuration

The NVM Configuration page provides a means to both configure and program the non-volatile memory (NVM) settings. The configuration includes both the static settings as well as the pre-configured state machine (PFSM) settings.

NVM Validation

The NVM Validation page reads out the NVM content and can be used to verify the contents of the NVM match what was programmed from the NVM Configuration page.

Watchdog Evaluation

The WatchDog Evaluation page is a unique page providing a graphical interface for both configuring and exercising the Watchdog feature on select PMICs.

5 Getting Started

Getting started involves the following steps:

1. Find the GUI within the Gallery.
2. Download the required software.
   a. GUI Composer Runtime for running the GUI from a web browser
   b. An offline copy of the GUI
3. Launch the GUI.

5.1 Finding the GUI

The PMIC GUI is based upon GUI Composer which is compatible with either Chrome™ (version 46+) or Firefox™ (version 38+). The Chrome™ web browser is recommended and used throughout this document for demonstration. The GUI is found through the TI Development tools at TI DevTools page. Navigating to the Gallery from the Explore tab, highlighted in red in Figure 5-1, is one way to enter the Gallery.

![Figure 5-1. GUI Composer Gallery](image)

When in the gallery, locate the Scalable PMIC's GUI panel shown in Figure 5-2. If the panel is not visible on the main page, then use the search bar and type the term PMIC.

---

**Note**

The name of the GUI has changed so panels are available for both the Programmable-Processor-PMICs-GUI and the Scalable-PMICs-GUI. The Scalable-PMICs-GUI version 2.0.0 is the latest version.
5.2 Downloading the Required Software

Both the standalone GUI and the GUI Composer Runtime are available from the PMIC panel. Again, the GUI Composer Runtime enables the GUI to be run through a web browser. This is a small download but still requires an internet connection to be able to run the GUI. By contrast the standalone GUI is much larger but does not require an internet connection.

The download options are found in the pop-up window, as shown in Figure 5-3, when the cursor is placed on the download icon. The upper three options are for a standalone download for the appropriate operating system, while the lower three are for the GUI Composer Runtime.
5.3 Launching the GUI

After the appropriate software has been downloaded, the GUI can be launched locally from the PC application or from the TI Cloud using the Gallery. To use the TI Cloud version of the GUI, simply click anywhere in the panel, shown in Figure 5-4, that is not associated with the download or information icons.

![Figure 5-4. GUI Panel Within the Gallery](image)

Figure 5-4. GUI Panel Within the Gallery

Figure 5-5 shows an example of the PC application.

![Figure 5-5. PMIC GUI Desktop Application](image)

Figure 5-5. PMIC GUI Desktop Application

Launching the GUI automatically loads the Device Home page, shown in Figure 5-6.
The GUI will not attempt to connect to the AEVM controller unless the register map or Quick-start page is entered. The GUI will attempt to automatically detect and connect to the correct Serial Port. Once this connection is made then the GUI will attempt to connect to the default I2C address of 0x48. If the address is not acknowledged, then the GUI will provide the Device Settings window to update the interface and address. Refer to the troubleshooting section for additional tips on resolving connection issues.

5.4 Connecting to a PMIC

The GUI and AEVM support both I2C and SPI with and without CRC. As mentioned previously, when entering the Register Map and Quick-start pages, the GUI will attempt to connect to any device with a non-CRC I2C interface at address 0x48. If an alternate address or configuration is needed, then the Device Settings window is provided to change the settings, as shown in Figure 5-7. This window can also be accessed in the drop-down menu below Options.
As shown in Figure 5-8, options are provided to select the device as well as the interface.

Select Device

The device selection will determine the register interpretation of data written to and read from the PMIC. Failure to select the correct device can result in erroneous data being written to the PMIC or data read from the PMIC to be misinterpreted.
I²C
The I²C1 address selection is limited to valid page 0 addresses of the PMIC. Once the I²C1 address is specified, the GUI will automatically determine the addresses for pages 1-4 as well as determine if the physical I²C2 interface for page 4 is to be used.

SPI
Similar to the I²C implementation, the GUI will automatically update the page information during communication.

Updating the Interface
In addition to the Option tab at the top of the GUI, in the Quick-start, Register Map, and Watchdog pages, there is a device settings bar that shows the current interface selection. Clicking the gear icon within the bar also opens the Device Settings window. In the NVM Configuration and NVM Validation pages, the interface selection is provided within the page. Please refer to those sections for more details.

![Figure 5-9. Device Settings Bar](image)

Note
Connecting to a device is not required to access the GUI pages. Specifically, connecting to a device is not required to create an NVM configuration as described in section Section 8.
6 Quick-start Page

From the initial Quick-start page in Figure 6-1, the Detect Devices box is provided to automatically detect all PMIC devices connected to the microcontroller's I²C or SPI² bus. The GUI will attempt to connect through I²C to the default address associated with the device. The Hardware Connected located at the bottom left of the GUI indicates that a device was found at that address. If no device can be found at the default address, then the device address (or configuration in the context of SPI) must be provided for at least one device connected to the GUI to use the DETECT DEVICES button. The interface connection can be changed by selecting the Device Settings from the Options drop-down menu at the top of the page.

Figure 6-1. Quick-start Scan Page

---

2 To support multiple devices on the same SPI bus, dedicated Chip Select pins are required for each PMIC. The current version of the GUI does not provide multiple dedicated Chip Select pins from the AEVM, and consequently can only communicate with one PMIC with SPI.
6.1 Device Scan Results

Figure 6-2 shows, for this example, two PMICs are detected. One PMIC is configured as the master, denoted with the $M$ in the blue circle, and the other as the slave. Additional information regarding the BUCK phase configuration and the $I^2C$ ID of each device is indicated. The device label is an editable field and can be updated to provide a custom naming convention. By clicking the Proceed button, the quick-start page will advance to the interface window where select device registers can be written or read.

Figure 6-2. Quick-start Scan Page Results
6.2 Configuration and Monitoring

Within the Quick-start page there are six tabs aligned horizontally for editing and four tabs aligned vertically for monitoring and accessing advanced features. These are highlighted in Figure 6-3. These tabs in the Quick-start page are described in the following sections. It is important to note that the GUI is continuously polling the PMIC to update the Interrupts, Resource Status, and GPIO Pin status. Additionally, each update or change in value results in communication to the PMIC to update the appropriate register. The device can be reset with a power cycle to restore the register settings to the NVM values.

![Figure 6-3. Quick-start Page Highlights](image)

**Note**

At the top of the Quick-start page is a drop-down menu to select the device when multiple PMICs are connected. This label is defined in Figure 6-2.

**Note**

All register fields are direct references to the device specification. When values within a field are repeated or reserved, the GUI will not show these possible values in the drop-down menu options.
6.2.1 System Info

As shown in Figure 6-4, the system info tab is related to the VCCA input voltage and, when applicable, additional voltage monitors. Drop-down menus are provided to show the possible values for each field.

Figure 6-4. System Information

---

**Note**

The phase configuration cannot be changed with either the Quick-start or the Register map pages. To change the phase configuration the device NVM must be reconfigured, please see Section 8.
6.2.2 BUCK

The phase configuration will determine which BUCKs are available for editing through the quick-start. In Figure 6-5, the BUCK2 information is not available because BUCK2 is multiphased with BUCK1. The BUCK1 is treated as the master and BUCK2 as the slave, with all of the properties of BUCK1 being applied to BUCK2. Please refer to device data sheet for a more detailed description of the fields and the associated operation.

**Figure 6-5. BUCK Configuration**

**Note**

The frequency selection register FREQ_SEL is protected and cannot be changed from the quick-start page. To change this field, similar to the phase configuration, the NVM must be updated accordingly.
6.2.3 LDO

From the LDO tab, configuration of the LDOs is available. Please refer to the device data sheet for a more detailed description of the fields and the associated operation. If a PMIC does not have LDOs, then the LDO tab will be omitted.

![LDO Configuration Figure](image)

---

6.2.4 GPIO

The GUI provides the interface to configure the PMIC GPIOs. When the GPIO is configured as an input, the GUI provides an additional mechanism to drive the GPIO from an associated AEVM pin and view the state change through the GPIO Status vertical tab on the right side of the page.

The PMIC GPIO can be configured as input or output or be mapped to internal functions within the PMIC. For this example, the PMIC is using GPIO1 and GPIO2 for the second I²C instance. The GPIO PIN STATUS window pane can be used to confirm the function and the level of each pin when configured as GPIO. The CONFIGURE GPIO LEVEL box appears, see Figure 6-7, when the GPIO direction is set to input to initially set the AEVM output level. Please ensure that the hardware platform is configured to support the intended GPIO operation.

**Note**

When evaluating a multi-PMIC solution, the control of the AEVM outputs are only for the AEVM which is connected to the GUI (connected to the PC through the USB port).

The GPIO pin status, see Figure 6-7, indicates the function of the GPIO as well as the current state (high or low) of GPIO that are not configured for special functionality. The colors are gray, red, and green. In addition to the color, a text description to the right of each indicator is also provided.
Figure 6-7. GPIO Configuration
6.2.5 Interrupts

From the interrupts tab the user can decide to mask or monitor various interrupt sources: State Machine, GPIOs, BUCKs, and so on.

The interrupt status, shown on the right side of Figure 6-8, can be used to monitor the interrupt events. The interrupts are grouped according to function and can be expanded to see each individual interrupt source. **TOP LEVEL INTERRUPTS** are read only and cannot be cleared. Other interrupts can be cleared at a register or bit level, as indicated by the reset symbol. An **ERROR** status with a red dot indicates that an interrupt has occurred while a **NORMAL** status with a green dot indicates that no interrupt has occurred or that the interrupt has been cleared. Typically, gray represents interrupts which are masked. If an interrupt has a **NORMAL** status with a gray dot, then this indicates that the interrupt is not applicable for the specified phase configuration. The GUI will ignore any attempt to unmask or generate an interrupt that is not applicable to the device phase configuration.

Figure 6-8. Interrupt Mask and Status
6.2.6 Miscellaneous Settings

The MISCELLANEOUS tab includes settings for the power good (PGOOD), spread spectrum configuration, and additional configurations of the PMIC.

![Figure 6-9. Miscellaneous Settings](image)

6.2.7 Advanced

The Advanced tab provides direct write and read access to and from the registers. The access format is 0xabc, where \( a \) is the page number and \( bc \) is the register address. Refer to the device data sheet for the page number and register address for a given device register.
7 Register Map Page

The Register Map page lists the different registers available for configuration. Unlike the Quick-start page, there is no device label to select if multiple PMICs are present. In the case of I²C, the device address should be selected in the Device Settings below the Options tab at the top of the GUI. In the case of SPI, the HW connection to the chip select pin will determine which PMIC the GUI communicates with and whose contents are displayed in the Register Map page.

The Register Map page is intended for direct read and writes to the PMIC registers. The read can be done individually or all at once. Similarly, writing to registers can also be all at once or individually. In the Immediate Write mode (option located at the top right of the page), only individual registers are written to immediately with each change in the Field View, change in bits, or change in hexadecimal value. In Deferred Write mode, the writing of a single register or all registers is deferred until the WRITE REGISTER or WRITE ALL REGISTERS button is selected.

Although visible from the Register Map Page, not all registers can be edited from this page. Specifically, the interface configuration cannot be changed, and similar with the Quick-start page the Buck frequencies cannot be changed. No error is reported, however, with each write is an associated read. The read will update the display so that writes to protected fields will accurately reflect that the write was unsuccessful.
8 NVM Configuration Page

The NVM configuration page is the main feature of the GUI and highlights the configurability of the PMIC. The configuration is comprised of the static and dynamic (PFSM) settings which are customizable for a broad range of applications. The NVM configuration page also provides the interface to download the configuration into the NVM of a target device. The download can be done after completion of creating a custom configuration, or this can be done with an existing NVM configuration.

8.1 Creating a Custom Configuration

The NVM Configuration page does not require hardware in order to develop an NVM configuration. Connection with an actual device is needed only when attempting to upload to a target device.

There are three mechanisms available to start development. The first is to use the Open Configuration feature below the File tab at the top of the screen. This would be a configuration previously saved with the Save Configuration feature below the same File tab. Second, standard configurations are also provided as templates and can be selected below the Select a template to start with. Figure 8-1 shows the initial Select view with the upload and template mechanisms selected.

Starting a validated template is recommended.

Figure 8-1. Open an Existing Configuration

Finally, device icons are provided on the left-hand-side which can be selected to create a single or multi-PMIC application, as shown in Figure 8-2. As devices are added the Device Name can be edited and the Master/Slave selection can be made. The GUI requires unique device names and only one master.
Once the configuration is uploaded or the devices for the application selected, the development flow will move through the Static Configuration and PFSM perspectives and then finally to the Program perspective as highlighted in Figure 8-3. Section 8.2.1 will describe how to program an existing NVM Configuration using the Skip to Programming option found at the bottom of Figure 8-3.
Note
It is not recommended to change or edit the selected devices of an existing configuration, with the exception of the device name. Doing so can break dependencies found in the PFSM. If during development it is discovered that the number or type of devices was defined in error, then a new configuration should be restarted from a blank or existing template.

8.1.1 Static Configuration

The Static Configuration perspective provides a similar interface as to what is found in the Quick-start page. The recommended flow is to start with the System Info tab on the far left, updating each block within the System Info tab and then proceeding to the next configuration tab. In a multi-device system, simply select the device to be configured from the Select a device to configure drop-down menu at the top left of the page.

Within each block are a list of registers and fields which directly match the device register and field names. It is recommended to use the data sheet specification to understand and properly set the field values for a given application. Within the BUCK blocks there is an additional graphical selection tool, see Figure 8-4, to abstract the register settings into the use cases also described in the device data sheet. The graphical selection tool will appear in the far right column of the display, providing the Configuration Use case name as well as the recommended inductor value.
Note
Only one device is visible at a time. Be sure that all devices in the application are defined.

Within the Static Configuration perspective, the GUI is monitoring the validity of the configuration. Specifically, for multi-device solutions the GUI is making sure that both the power (VCCA and nPWRON) and interface selections match. By clicking on the Validation Failed text at the bottom of the perspective a pop-up window, as shown in Figure 8-5, will describe all of the issues which are invalid and preventing the next stage of the development.

In this example, all three devices have the same I²C address(es). After updating each device to a unique address, the GUI now shows Validation Success and the Define PFSM button is now active.
In addition to the check of the static settings, in devices which support functional safety, there is an additional check of the safety related features. By clicking on the **Functional Safety Assumptions not met** text, a pop-up window, as shown in Figure 8-7, displays. The window lists the parameters related to the device’s functional safety assumptions. Refer to the device’s functional safety manual and the application’s functional safety goals, in order to confirm that the selected settings meet their functional safety target.

When transitioning to the PFSM perspective from the static settings if any values were not updated, then a warning message will appear. Values that are not updated will appear with a yellow highlight around the value. In this example, only the I^2^C addresses have been updated. Texas Instruments recommends that all settings that are highlighted as unchanged should be reviewed and confirmed.
Note
The GUI does not provide an auto-save feature. Save often using the Save Configurations below the File tab shown in Figure 8-9.

8.1.2 Pre-Configurable Mission States (PFSM)
While the static configuration was done on a per device basis, the perspective of the PFSM is that of all devices working together. Individual commands are created for each device, but they are grouped in the context of states and transitions of the system solution.

When entering the PFSM perspective and no template was chosen from the SELECT perspective, template options will be presented to aid in the development of the PFSM. Figure 8-10 shows the two templates available.
Figure 8-10. PFSM Starting Templates

Once the template is selected, then the GUI transitions into the PFSM perspective.
The PFSM perspective provides a work space on the left-hand-side to draw the PFSM. How to add and remove states and transitions is described in Table 8-1 as well as within the How to edit a Template pop-up window, located in the bottom left corner.

Table 8-1. Actions to Edit the State Machine

<table>
<thead>
<tr>
<th>Action</th>
<th>Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new state</td>
<td>Shift+left mouse click</td>
</tr>
<tr>
<td>Create a transition</td>
<td>Shift+left mouse click+drag from within the source state to the destination state</td>
</tr>
<tr>
<td>Create a loop</td>
<td>Left mouse click on the loop icon within the state</td>
</tr>
<tr>
<td>Move a state</td>
<td>Left mouse click within the state and drag</td>
</tr>
<tr>
<td>Delete</td>
<td>Left mouse click on the state, transition, or loop and then press the backspace(delete)</td>
</tr>
<tr>
<td>Zoom</td>
<td>Place mouse within the drawing space and scroll</td>
</tr>
<tr>
<td>Pan</td>
<td>Left mouse click + drag from any blank space within the work space</td>
</tr>
</tbody>
</table>

Note

The GUI does not provide an auto-save feature. Save often using the Save Configurations below the File tab shown in Figure 8-9.

Developing the PFSM can be an iterative and non-linear process. The linear process listed here is only intended to show functionality and a basic work flow. It is possible to return to earlier steps (steps 1-5) at any time and make changes.

1. Create a state diagram
   a. Adding States
   b. Adding Transitions (Triggers)
2. Global Settings
3. Power Sequences
4. Trigger Settings
5. Trigger Priority List
6. PFSM Validation

8.1.2.1 Creating a State Diagram

The state diagram which is developed in the PFSM panel includes the user defined mission states and three hardware states, SAFE_RECOVERY, LP_STANDBY, and RUNTIME_BIST. The user defined mission state STANDBY is required in order to bridge between the hardware states and the missions states. The SAFE state is required as the transition between mission states and the hardware state SAFE_RECOVERY. As shown in Figure 8-12, the panel focuses on the mission states and the SAFE_RECOVERY, LP_STANDBY, and RUNTIME_BIST hardware states which can be accessed from the mission state via the PFSM.

WARNING

STANDBY, SAFE, and SAFE RECOVERY states are required, as defined in the data sheet, in order to meet device specifications.

Figure 8-12. PFSM State Diagram Panel

Figure 8-13 shows the complete state machine with the additional transitions associated between the hardware and mission states. The complete state machine can be viewed by selecting the export icon (next to GENERATE PROGRAM) in the lower right corner. Please refer to the device specification for a more detailed description of the states and the transitions.
8.1.2.2 Global Settings

As states are added they will appear in the GLOBAL SETTINGS panel, as shown in Figure 8-14. The names of the states are configurable but the type of state is limited to either a user definition or a Hardware State. Hardware states are already defined within the finite state machine within the PMIC and by definition there is no power sequence associated with transitions to hardware states and no transitions can be defined from Hardware states.

In addition to the states, from the GLOBAL SETTINGS the user can select which state the PFSM will start from. This effectively determines which triggers will be unmasked once the device leaves the hardware finite state machine and transitions to the user PFSM, mission state.

The PFSM Step Delay setting is also part of the GLOBAL SETTINGS. The PFSM Step Delay setting will determine which time interval the GUI will use to attempt to meet the required delays found throughout the power sequences. The actual delays are a function of the desired delay, instruction being used, as well as the PFSM Step Delay. Instruction delays are limited to either 6 or 8-bit multiples of the step delay. In the event that the GUI cannot reach the desired delay time with the existing step delay, then the GUI will add an instruction to change the step delay temporarily to reach the desired delay time. If the step size is actually larger than the desired
delay, then the GUI inserts a command to change the step delay to support the delay time, and after the delay is complete, the GUI will insert another command to change the step delay back to the original value. Whenever the GUI makes an adjustment, the smallest step size is chosen which can still provide the desired delay. Table 8-2 is provided to exemplify the actual delay versus requested delay times as a function of the PFSM Step Delay.

**Note**
Choosing a PFSM Step Delay which is a common factor of the majority of the delays needed in power sequencing will optimize the memory usage in the device.

<table>
<thead>
<tr>
<th>PFSM Step Delay (us)</th>
<th>Delay Requested(us)</th>
<th>Delay Instruction</th>
<th>Actual Delay (us)</th>
</tr>
</thead>
<tbody>
<tr>
<td>25.6</td>
<td>2500</td>
<td>DELAY_IMM (8-bit)</td>
<td>2483.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>REG_WRITE_VCTRL_IMM(6-bit)</td>
<td>2457.6</td>
</tr>
<tr>
<td>204.8</td>
<td>40000</td>
<td>DELAY_IMM (8-bit)</td>
<td>39936</td>
</tr>
<tr>
<td></td>
<td></td>
<td>REG_WRITE_VCTRL_IMM(6-bit)</td>
<td>39321</td>
</tr>
<tr>
<td>409.6</td>
<td>300000</td>
<td>DELAY_IMM (8-bit)</td>
<td>299827</td>
</tr>
<tr>
<td></td>
<td></td>
<td>REG_WRITE_VCTRL_IMM(6-bit)</td>
<td>294912</td>
</tr>
</tbody>
</table>

**8.1.2.3 Power Sequence**

Power sequences are dependent upon the target state definition, and therefore it is required to define the state in the global settings before creating a power sequence. In addition to the target state, there are options to select the sequence type. The sequence types Power Up, Power Down, and Reset come pre-populated with ACTIVATE and or DEACTIVATE commands based upon the sequence type. All sequence types have the TRIG_MASK pre-populated. These commands are described in Section 8.1.2.3.1.

Once a new sequence has been created, then the sequence name is added to the list of sequences (see Figure 8-15), and the sequence can be edited (lightning bolt), updated (pencil), or deleted ('X'). The update simply allows the name of the sequence to be updated as well as the target state. Using the edit icon will open a new window as shown in Figure 8-16.
Figure 8-15. How to add a Power Sequence

Figure 8-16. Power Sequence Command Window
From this window, commands for each PMIC can be added and the timing relationship between each command is represented. Arrows are provided to move commands within the sequence.

**Note**

Delays in the **ADD ACTION** or **UPDATE ACTION** windows are relative to the previous action. Delays shown in the Power Sequence Commands list are relative to the start of the sequence.

There is a distinction between commands which have Rail Connections and commands which do not. The commands with Rail Connections are typically representative of physical outputs from the device and voltage monitors. The Rail Connections are what will appear in the power sequence diagram as described in section **Section 8.1.2.3.3**. The names of the Rail Connections are editable and can be updated to more meaningful names related to the application.

Initially, the trigger masks for each device are provided. As additional commands are added, they will always be placed above the trigger masks. The trigger masks can be moved in the sequence order, but typically these are the last commands in the sequence. The trigger mask at the end of the power sequence is automatically generated based on the available triggers of the destination state. This mask can be edited to mask triggers from triggering a power sequence and a state change. Before editing the mask, it is recommended to define the triggers as described in the **Section 8.1.2.4**.

**8.1.2.3.1 Power Sequence Resources and Commands**

This section lists the different commands and resources available. The description is provided with reference to the PMIC instruction set which is described in the device data sheet.

**Resources and Commands**

Not all commands are available on all devices. Refer to the device data sheet.

1. **BUCKx**
   
   The BUCK resource is an abstraction of the assembly instructions **REG_WRITE_VCTRL_IMM** and **REG_WRITE_VOUT_IMM**. Selecting either the VCTRL or the VOUT tab in the update action window will determine which instruction is applied. Within each tab are the various parameters of each instruction.
   
   BUCKx commands are available for each available BUCK. If BUCKs are multi-phased then the grouping is reflected in the resource name, for example BUCK1_2_3_4, but only the master BUCK information is shown in the parameter window. In the resulting program, the master buck will be the only one reflected in the instruction.

2. **BUCKx Monitor**
   
   The BUCK monitors are a special subset of the **REG_WRITE_VCTRL_IMM** and **REG_WRITE_VOUT_IMM** instructions. The parameters which are not used for this resource are not selectable. The VIN tab is the same but represents the monitor voltage setting.

3. **LDOx**
   
   Similar to the BUCK and BUCK Monitor Resources, this is an abstraction of the assembly instructions **REG_WRITE_VCTRL_IMM** and **REG_WRITE_VOUT_IMM**. Selecting either the VCTRL or the VOUT tab in the update action window will determine which instruction is applied. Within each tab are the parameters of each instruction.

4. **nRSTOUT**
   
   The nRSTOUT command writes or clears the nRSTOUT bit found in the MISC_CTRL register. The command is an abstraction of the **REG_WRITE_MASK_IMM** assembly instruction to the address 0x81, register MISC_CTRL. The data and mask are determined by the selection of unchanged, high, or low. The use of the *unchanged* selection has no impact and only serves as a delay of one instruction cycle.

5. **WAIT**
   
   The wait command provides a conditional branch in the instruction set, similar to an *if* or *while* statement. When the timeout is provided, the wait condition is effectively an *if statement* continuing to the next instruction if the condition is true and jumping to the destination if the condition is false. If the timeout is non-zero, then the PMIC will wait until the condition is true and then execute the next instruction or until the timeout is
reached and then jump to the destination. The destination must always be after the wait command because the skip count of the wait instruction is always positive.

---

**Note**
Using a timeout is not recommended with multiple devices as the other devices have no information of how long the wait took if the condition was met before the timeout.

---

6. **JUMP**

The jump command is special implementation of a wait command which has a timeout of 0 and a condition which is always false. The destination must be after the jump command.

7. **RESET_BUCKs**

The RESET_BUCKs command is a direct write to the BUCK_RESET_REG register at address 0x87. In this command the resets are per BUCK and each BUCK must be configured even when the BUCKs are multi-phased. The RESET_BUCKs command is translated into a REG_WRITE_MASK_IMM command to address 0x87 to either clear or set bits 0 through 4, representing BUCKS 1-5.

---

**CAUTION**
The RESET_BUCK command will stop the BUCK switching. This command should only be used in power down sequences.

---

8. **GO_TO_LP_STANDBY**

The GO_TO_LP_STANDBY command is a direct write of 1 to the LDOINT disable bit found in the LDOINT_CTRL register, address 0x21. LDOINT is a self-clearing bit. The GO_TO_LP_STANDBY command is translated into a REG_WRITE_MASK_IMM command to address 0x21, with a data value of 0x01 and a mask of 0xFE.

9. **SET_WD_LONGWINDOW**

The SET_WD_LONGWINDOW command is a direct write to the WD_LONGWIN field found in the WD_LONGWIN_CFG register, address 0x405. This field is for programming the duration of the Watchdog Long Window. The SET_WD_LONGWINDOW command is translated into a REG_WRITE_MASK_IMM command to address 0x405, with a data value range from 0x00 to 0xFF, and a mask of 0x00. A value of 0x00 is approximately 100ms while a value of 0xFF is approximately 12 minutes.

10. **GO_TO_LONGWIN**

The GO_TO_LONGWIN command is a direct write of 1 to the WD_RETURN_LONGWIN bit found in the WD_MODE_REG register, address 0x406. This command will cause the watchdog to return to the Long-Window after completion of the current watchdog-sequence. The GO_TO_LONGWIN command is translated into a REG_WRITE_MASK_IMM command to address 0x406, with a data value of 0x01 and a mask of 0xFE.

11. **FIRST_STARTUP_DONE**

The FIRST_STARTUP_DONE command is a direct write of 1 to the FIRST_STARTUP_DONE bit found in the RTC_CTRL_2 register, address 0xC3. The FIRST_STARTUP_DONE command is a translated into a REG_WRITE_MASK_IMM command to address 0xC3, with a data value of 0x80 and a mask of 0x7F.

12. **INCREASE_RECOVERY_COUNT**

The INCREASE_RECOVERY_COUNT command is a direct write of 1 to the INCREASE_RECOVERY_COUNT bit found in the RECOV_CNT_PFSM_INCR, address 0xA5. This bit is self-clearing, so each command increments the recovery counter. The INCREASE_RECOVERY_COUNT command is translated into a REG_WRITE_MASK_IMM instruction to address 0xA5, with a data value of 0x01 and a mask of 0xFE.

13. **ACTIVATE**

The ACTIVATE command is a composite of several commands associated with a power up sequence. These commands include the following:

a. REG_WRITE_MASK_IMM to ENABLE_DRV_STAT to clear SPMI_LPM_EN.
b. REG_WRITE_MASK_IMM to VCCA_VMON_CTRL to either clear or set VCCA_VMON_EN, depending upon the value selected from the ACTIVATE command window.

c. REG_WRITE_MASK_IMM to MISC_CTRL to either clear or set AMUXOUT_EN/REFOUT_EN and CLKMON_EN, depending upon the value selected from the ACTIVATE command window. Included in this instruction is the clearing of LPM_EN.

14. DEACTIVATE

The DEACTIVATE command is a composite of several commands associated with a power up sequence. These commands include the following:

a. REG_WRITE_MASK_IMM to ENABLE_DRV_STAT to set SPMI_LPM_EN.

b. REG_WRITE_MASK_IMM to VCCA_VMON_CTRL to either clear or set VCCA_VMON_EN, depending upon the value selected from the DEACTIVATE command window.

c. REG_WRITE_MASK_IMM to MISC_CTRL to either clear or set AMUXOUT_EN/REFOUT_EN, depending upon the value selected from the ACTIVATE command window. Included in this instruction is the setting of LPM_EN.

15. ENDRV

The ENDRV command is a direct write to the FORCE_EN_DRV_LOW bit found in the ENABLE_DRV_STAT register, address 0x82. The ENDRV command is a translated into a REG_WRITE_MASK_IMM command to address 0x82, with a data value of 0x08 or 0x00, and a mask of 0xF7.

16. DELAY_IMM

The DELAY_IMM command is a direct representation of the DELAY_IMM instruction. The delay specified in this command is applied to all devices.

---

**Note**

The assembler will optimize DELAY_IMM instructions and combine with the following instruction if that instruction includes a timing parameter.

17. REG_WRITE_MASK_IMM

The REG_WRITE_MASK_IMM command is a direct representation of the REG_WRITE_MASK_IMM instruction. The REG_WRITE_MASK_IMM command includes a mask to write or clear specific bits without impacting other bits within the register.

18. TRIG_MASK

The TRIG_MASK command is a direct representation of the TRIG_MASK instruction. The trigger mask will determine which interrupts are enabled and disabled. Using the Automatic trigger will set the trigger based upon the trigger settings from the TARGET STATE.

19. REG_WRITE_IMM

The REG_WRITE_IMM command is a direct representation of the REG_WRITE_IMM instruction. The REG_WRITE_IMM command overwrites all bits within the register specified.

20. REG_WRITE_MASK_SREG

The REG_WRITE_MASK_SREG command is a direct representation of the REG_WRITE_MASK_SREG instruction. The REG_WRITE_MASK_SREG command includes a mask to write or clear specific bits without impacting other bits within the register. The data is sourced from the specified scratch register.

21. SREG_READ_REG

The SREG_READ_REG command is a direct representation of the SREG_READ_REG instruction. This command copies the contents of the register to the specified scratch register.

22. SREG_WRITE_IMM

The SREG_WRITE_IMM command is a direct representation of the SREG_WRITE_IMM instruction.

23. DELAY_SREG

The DELAY_SREG command is a direct representation of the DELAY_SREG instruction. This delay is different than the other delays found in the resources and commands. The delay is only applied to the device specified.
8.1.2.3.2 Sub-sequences

Sub-sequences are groups of commands within the power sequence and are associated with the JUMP or WAIT instructions. Functionally, the sub-sequence is simply a destination label for the JUMP or the WAIT statements to jump to. Graphically, the sub-sequence can be used to group commands and then the entire group can be moved within the power sequence. In Figure 8-17, the WAIT instruction is used to test GPIO1, if GPIO1 is high, then the timeout occurs and the execution jumps to the SKIPBUCK5 label and continues execution. Specifically, if GPIO1 is low then BUCK5 is enabled, if GPIO1 is high, then the regulator is not enabled. Figure 8-18 shows that there are no instructions within the sub-sequence. Instructions placed within or after the sub-sequence will be chronologically equivalent. Again, the main benefit of placing instructions within the sub-sequence is to logically group the commands and then to move them as a group when needed.

Figure 8-17. WAIT Command Action
Waiting and JUMP statements can only jump forwards in the sequence of commands. The destination can never be placed before the JUMP or WAIT statement.

### 8.1.2.3.3 Power Sequence Editing Tools

In addition to the four editing tools for each individual command (update, move up, move down, delete), there are four tools available for editing the power sequence in its entirety. From left-to-right, the tools are export power sequence, copy sequence, paste sequence, and reverse sequence (see Figure 8-19). The copy, paste, and reverse sequence tools create a convenient way to copy a power sequence, for example, a power-on sequence, and to paste in a new sequence, then reverse in order to create a power-off sequence.

#### Note

The reversal is not applied to the TRIG_MASKS as these are always intended to be at the end of the sequence. The reversal is only of the order of the commands and not the timing relationship or polarity; enable does not become disable.
The export power sequence provides a more complete graphical view which can be exported. From this view the user has the ability to provide inputs for the conditional WAIT command and generate timing diagrams for different conditions. As shown in Figure 8-20, either the true condition of the timeout can be selected and the timing diagram is updated appropriately.

**Note**

Texas Instruments recommends exporting power sequences to confirm that the timing aligns with system requirements.

---

**Figure 8-20. Exported Sequence with Variable Conditions**

**8.1.2.4 Trigger Settings**

The maximum number of triggers available is 28. Please refer to the device specification for the usage of reserved triggers. The GUI will ensure that the maximum number of triggers is not exceeded and manage the usage of triggers across devices in a multiple PMIC application.
The trigger settings identify what triggers will move the PMIC operation from one state to another. In the context of the GUI, the arrows between states (or arrows looping back to the same state) must have at least one trigger definition. An example is used to outline the steps configuring the trigger settings. For this example, the IMMEDIATE_SHUTDOWN going high on any device will trigger all devices to execute a power down sequence and then transition to the SAFE state, which in turn will automatically transition all devices, without power sequence, to the hardware state SAFE_RECOVERY, to reset the devices. The following steps are how to setup this example.

1. Select the transition between the STANDBY and SAFE states, by clicking on the transition in the diagram.

   ![Diagram](image)

   **Figure 8-21. Trigger: STANDBY to SAFE**

2. In the From States add ACTIVE, so that both the ACTIVE and STANDBY states are selected.  
3. In the 'Add Devices' select Any, so that all devices appear in the window.
4. From the Trigger Source drop-down menu, select IMMEDIATE_SHUTDOWN.
5. From the Trigger Type drop-down menu, select HIGH.
6. Select the Immediate check box. This means that the trigger can happen immediately and does not wait for the current sequence to finish.

---

4 The Reuse Trigger button is an alternative option. This would mean that step 2 would be omitted. After step 7, the ACTIVE to SAFE transition would be selected. At this point the 'Reuse Trigger' button would be selected and then the same trigger used for the STANDBY to SAFE would be selected.

5 While an example, Texas Instruments recommends that the IMMEDIATE_SHUTDOWN trigger be present in all devices. For other triggers, it is acceptable that the trigger is present in only one device.
Figure 8-22. Trigger: STANDBY to SAFE (continued)

7. Click ADD
8. Now click on the transition between SAFE and SAFE_RECOVERY.
9. In the Add Devices window, select Any
10. From the Trigger Source drop-down menu, select 1, and from the Trigger Type select High. This combination is always true and will result in a trigger.

**CAUTION**

A Trigger Source of 1 and a Trigger Type of High will always result in a trigger.

**Note**

Since SAFE_RECOVERY is a hardware state the trigger will not have an associated power sequence. This is indicated by the EXT attribute in the trigger description. Similarly, the RUNTIME_BIST will also have the EXT attribute.

11. Click ADD
Figure 8-23. Trigger: SAFE to SAFE_RECOVERY

At the bottom of the TRIGGER SETTINGS, highlighted in Figure 8-23, is a summary of the trigger(s) associated with a transition. A scroll bar is provided to see the bottom of the pane. The last step is to associate a power sequence with the transition. Since SAFE_RECOVERY is a hardware state, the EXTERNAL flag is set and no sequence is needed in the transition to SAFE_RECOVERY. The transitions to SAFE, however, do require a sequence. Making the association between the trigger and the sequence is listed in the following instructions.

1. Click on the transition between STANDBY and SAFE (or ACTIVE and SAFE).
2. Click the lightning bolt icon. This will bring up a window showing all of the sequences which have the same destination or target state. In this case there is only one, any2safe.

Figure 8-24. Mapping a Sequence to a Trigger

3. Select the sequence and then click MAP TO TRIGGER. The Trigger Setting for the transition is now complete.
Figure 8-25. Completed Trigger Settings

Once all of the transitions have been assigned triggers and all of the triggers have been associated with power sequences, then the default TRIGGER MASKS within the power sequences will be updated. Please note the various components and relationships discussed to this point:

1. States
   - The states are either hardware or mission states.

2. Transitions
   - Transitions have a source and target state. Transitions can have multiple triggers but require at least one. Transitions to the same target state can share the same trigger.

3. Triggers
   - Available triggers are defined in the device specification. Each trigger can have only one power sequence associated with it. Multiple triggers can share the same power sequence. In the special case that the transition target state is a hardware state, the trigger type is EXT and there is no power sequence.

4. Power Sequences
   - Power sequences are defined in terms of the target state and therefore can potentially be associated with multiple triggers or transitions. Within the power sequence is the trigger mask. The automatic trigger mask is defined by all transitions from the target state and the triggers defined in those transitions. Manual trigger masks can be used to create custom trigger masks. In the TRIG_MASK command there is an option to select either an automatic or a manual trigger mask.

8.1.2.5 Trigger Priority List

Triggers are initially prioritized based upon the TRIG_SEL value for each trigger as defined in the data sheet. Lower values have higher priority. It is important to confirm that the priority within the TRIGGER PRIORITY LIST matches the desired priority of the application. Figure 8-26 shows the priority list from the simple example in the previous section. Click the arrows within the list to move triggers up and down in priority.
8.1.2.6 PFSM Validation

The TRIGGER PRIORITY LIST is the last component to building a PFSM configuration. When the configuration is complete, the PFSM validation should be run in order to check and validate the PFSM content. Within the PFSM Validation view, click the **Validate PFSM** button.

Within the PFSM view, a list of results will be displayed. Any errors or warning will be accompanied by instructions and recommendations. Errors and warnings will not prevent program generation but indicate a potential risk in device performance within the application. It is recommended to address all errors as this can prevent proper compilation or file generation. Once all errors have been addressed, click the **GENERATE PROGRAM** button to move to the PROGRAM perspective.
8.2 Program

Note
Before programming is another good place to save the configuration, see Figure 8-9

The program page shows the results of the generated program in the Generated Program tab, as shown on the left side of Figure 8-28. This is a text format file and a scroll bar is available to view the entire content. On the right side are the control mechanisms for programming.

Figure 8-28. NVM Programming

The Select Device drop-down menu is provided when multiple PMICs have been configured. The associated program appears in the Generated Program tab when a device is selected. This will also determine which program will be saved and programmed.

The Select current interface will determine which physical address is used to verify the connection and program.

Two options are provided for saving the program, Save as Assembly Code and Save as Binary Code. The Save as Assembly Code is the same format as what is shown in the Generate Program tab. The Save as Binary Code format is of the register addresses and the hexadecimal values at those addresses. Both of these formats can be uploaded to the program page and programmed into the selected device without the use of the configuration steps, as discussed in Section 8.2.1. The binary format can also be used in the NVM Validation page to validate the NVM contents of a device. Once the physical connection is verified, then the device can be programmed.

Note
Texas Instruments recommends saving all three file types: Configuration, Assembly, and Binary.
8.2.1 Program an Existing NVM Configuration

The NVM Configuration page can also be used to program a device with an existing NVM Configuration in the assembly or binary format. The process is simply to start at the beginning of the page and choose which type of device to program by clicking the device icon, as shown in Figure 8-29. Once a device is chosen, click the Skip to Programming button to go directly to the programming page.

![Figure 8-29. Skip to Programming with an existing NVM Configuration](image)

The programming perspective has changed slightly from what was described in Section 8.2. As shown in Figure 8-30, only the Uploaded Program File tab is available, the save options are disabled, and the Select Device reflects the device selection at the beginning. The interface selection should match the device being programmed. If the interface is not setup correctly the connection indicator at the bottom of the screen will reflect that the Hardware not Connected. Failed to connect and any attempt to Verify Connection will fail. Once the correct device is connected and the file to program selected, click Verify Connection and then Program Device.

---

6 When multiple devices are connected to the AEVM, ensure that for I2C that the address is that of the device to be programmed. In the case of SPI, make sure that the chip select is connected to the device to be programmed.
8.2.2 NVM Configuration Special Use Case: Changing the Communication Interface

The GUI tool writes the register settings using the identified interface and then uses the bulk programming method to transfer the register settings to the NVM. In the event that the NVM image uses a different interface, then it is important that the device being programmed supports both interfaces. When the GUI writes to the register settings to change the interface (SPI to \(I^2C\) or \(I^2C\) to SPI), the GUI will pause and display a prompt, see Figure 8-31, to change the hardware configuration to enable the new interface. This message specifically refers to the EVM, but can be generalized to any hardware configuration where changes are made to transition from \(I^2C\) to SPI or SPI to \(I^2C\).
8.2.3 Lock Option During NVM Programming

The PMIC NVM can be permanently locked, preventing any changes to the NVM configuration. While this is not recommended during development, the feature is supported by the GUI. During the programming, a dialog window appears, see Figure 8-32, with the option to lock the NVM. Once this is done, then the PMIC NVM cannot be changed.
Figure 8-32. NVM Lock Option

**CAUTION**

Locking a device is permanent.

**CAUTION**

Locking a device is permanent.

*Figure 8-32. NVM Lock Option*

- **CAUTION**
  - Locking a device is permanent.
9 NVM Validation Page

Note

Texas Instruments recommends as best practice to always use the NVM validation to confirm the correct configuration of the device following programming from the NVM Configuration page.

The NVM Validation page is used to download the current register or NVM settings to the host PC or compare the settings to a file from the host PC. One of the important aspects of this page is that the NVM settings are accessed by overwriting the current register settings. If the NVM Settings button is selected, as shown in Figure 9-1, when the DOWNLOAD CONFIGURATION button is selected, then the GUI immediately issues a set of commands to the PMIC to overwrite all existing register settings with the contents from NVM. This will overwrite any settings or configuration to the device made through the Quick-start or Register Map pages. After the overwrite is complete, then the register contents are read out through the communication interface.

Figure 9-1. NVM Validation

The top right of the page indicates which of the Current Settings or the NVM Settings, are being read. On the left side of the page is an interface to select a known file to compare the read contents to. This provides a quick visual pass/fail response to evaluate the content read. The DOWNLOAD CONFIGURATION option is found on the right side of the page.

Compare the Current or NVM Settings with an existing binary file

1. Confirm that the correct device is connected.
   a. Select the correct Device Type.
   b. Select the correct Communication Interface.
2. Select the binary file from the host PC to compare the device NVM with.
a. Use the Drag and Drop feature or the file navigator.
b. When a valid file is selected, the COMPARE button will become active.

3. Press the COMPARE button.

**Download the Current or NVM Settings to a binary file.**

1. Confirm that the correct device is connected.
   a. Select the correct Device Type.
   b. Select the correct Communication Interface.
2. Select the **Current Settings or NVM Settings** button
3. Press the **DOWNLOAD CONFIGURATION** button.
10 Watchdog Page

The Watchdog page is an interactive evaluation tool for exercising the watchdog functionality in both TRIGGER and Q&A modes. This tool uses the MSP432E microcontroller on the AEVM to create the watchdog stimulus for both correct and incorrect use cases. Status monitoring is provided to show the PMIC response.

To exercise the watchdog module please make sure the following conditions are met in the PMIC:

1. The device supports the watchdog feature
2. The PMIC is in a mission state. A hardware state, like **SAFE RECOVERY**, will prevent the watchdog from operating.
3. NRSTOUT (found in the register MISC_CTRL) must be **1**
4. WD_EN (register WD_THR_CFG) must be **1**
5. If applicable to the device, any GPIO configured as DISABLE_WDOG should be logic **low**
6. WD_PWRHOLD must be **0**
7. For evaluation purposes it is recommended to set WD_RST_EN to **0** so that the device does not enter **WARM RESET** during the evaluation.

**Trigger Mode**

The watchdog page will reflect the settings in the controls section. In order to change from QA to TRIGGER mode, the *Edit/Enable* indicator, as highlighted in yellow in **Figure 10-1**, should be switched to *Enable*. Once in the trigger mode, switch back to *Edit*, and adjust the default Window-1 and Window-2 values to a time frame that does not exceed the limits of the AEVM.

With valid timing windows, the watchdog can be re-enabled and the watchdog sequence started.

**Start Sequence:**

1. Enable the watchdog, select 'Enable'
2. Select the mode, 'TRIGGER' or 'Q&A'
3. Edit the AEVM trigger waveform, select 'Edit'
4. Adjust 'Window-1' and 'Window-2'
5. Select the ‘Sequence Configuration’
6. Enable the watchdog, select ‘Enable’
7. Select ‘START SEQUENCE’

In the EVENT STATUS view, the WD FIRST OK is illuminated and green, see Figure 10-2, indicating that the first watchdog trigger sequence was received correctly. The PMIC is continuously polled during operation and the ERROR STATUS view is updated.

Figure 10-2. Watchdog Trigger Mode

To stop the evaluation, first use the control to set the RETURN TO LONGWINDOW, second switch from Enable to Edit mode, and then click STOP SEQUENCE.

Stop Sequence:
1. Select RETURN TO LONGWINDOW
2. Select Edit
3. Select STOP SEQUENCE

The sequence configuration can be modified to intentionally provide an incorrect sequence, using the drop down menu ‘Sequence Configuration’. The incorrect timing and the consequent bad event is shown in Figure 10-3. To evaluate this configuration, first, switch from Edit to Enable mode, second, disable the RETURN TO LONGWINDOW, and then click START SEQUENCE.
Figure 10-3. Invalid Trigger Watchdog Input

The errors can be cleared using the icons to the right of each error, or by clicking Clear All.

**Q&A Mode**

As previously stated, the Q&A mode can be selected when the Edit/Enable indicator is moved to Enable.
Once the Window configuration is updated for the Q&A a similar process can be employed to evaluate the Q&A mode. Figure 10-5 shows a correct sequence of answers to the questions while Figure 10-6 shows an incorrect answer.

Figure 10-5. Watchdog Q&A Valid Response
Figure 10-6. Watchdog Q&A Invalid Response
11 Additional Resources
1. SimpleLink™ Ethernet MSP432E401Y MCU Launchpad™ Development Kit
2. GUI Composer User’s Guide.

12 Appendix A: Troubleshooting
12.1 Hardware Platform Not Recognized

The GUI will automatically connect to the AEVM (micro controller with the analog evm controller firmware) and then to the PMIC. Typically, if the GUI cannot find the hardware platform this is due to either a faulty USB connection or the GUI is attempting to connect to the wrong communication (COM) port. The hardware platform will enumerate as three devices; two CDC classes and one DFU class. From another program, like the device manager in windows, the user can verify which COM port is the ACCtrl and which is the ACCtrl Console. From the GUI option, the user should select the COM port number of the ACCtrl and not the ACCtrl Console. The AEVM supports a baud rate of 115200.

Other devices connected to the PC, may also enumerate at CDC class devices and the GUI may attempt to communicate with these devices. If no response is made from the device, then it is possible that the GUI will not attempt to connect to other devices until the current device responds.

Only one AEVM should be connected to a host (MAC of PC) at one time. The GUI does not support the ability to handle and respond to multiple AEVM devices connected to the host.
12.2 PMIC Device not found

If the hardware platform is connected but the PMIC device is not found, then the GUI will report an error regarding the address: Connected to AEVM Controller, but failed to connect to device TPS6594x_external on I2C @xx. In the case of I2C this means that the address was not acknowledged (NACKed). Perform appropriate I2C bus checks: appropriate pull-up resistors, verify that no device is holding the clock low (clock-stretching), and so forth. Verify that the correct I2C address is being sent. The default address which the GUI uses may not be correct and it is necessary to update the address using the Device Settings below the Options tab.

Similarly with SPI, ensure that the hardware connection is correct and that the chip select is connected to the appropriate PMIC when multiple PMICs are in use.
13 Appendix B: Advanced Topics

13.1 Scripting Window

Scripting is a convenient way to send a sequence of commands (reads or writes) to the PMIC device registers as opposed to the individual commands associated with an update to a parameter in either the quick-start or Register page views. Scripting is found below the Options tab located at the top of the GUI. Opening the scripting window will open a new window while the GUI window will still be active as shown in the following paragraph.

Figure 13-1. Default Scripting Window

Figure 13-1 shows the initial scripting window and the default text provided. This file can be edited to provide a desired sequence of commands. One quick way to start using the scripting window is to use the record feature to capture a sequence of commands. In the upper right hand corner is the record icon. Hovering the cursor over the icon will reveal a Start Recording help box. In the example shown in Figure 13-2 and Figure 13-3, the recording is started and then when returning to the GUI window the Register Page is used to read DEV_REV and NVM_CODE_2 and then write to the BUCK1_CTRL register. Once these sequence of actions are completed, then returning to the scripting window will reveal the recorded commands. At this point, the recording can be stopped and these commands can be expanded and repeated for the various registers. Once the sequence is complete, then click the Run icon to execute the sequence.

Figure 13-2. Scripting, Recording Register Read and Writes
Figure 13-3. Scripting, Running a recorded sequence
14 Appendix C: Known Limitations

This section contains known limitations of the GUI. Please use the support forums to report any issues or limitations found that are not on the following list.

Table 14-1. GUI Limitations

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CRC_15 and CRC_16 are included for comparison of NVM Validation but these registers cannot be edited</td>
<td>None. The GUI will report that the NVM files do not match. Inspect the registers and disregard errors associated with CRC_15 and CRC_16, registers 0x00FE and 0x00FF respectively.</td>
</tr>
<tr>
<td>2</td>
<td>Modifying Device Type and its configuration (for example, Master/Slave, Phase Configuration.. etc) is not recommended after creating PFSM as it may not produce expected results</td>
<td>In the case of modifying the phase configuration, remove all references in the PFSM before attempting to change the phase configuration. Changing the device type will require starting from a new or blank template.</td>
</tr>
<tr>
<td>3</td>
<td>SPI Hardware connection status displayed in the status bar can be detected incorrectly.</td>
<td>Use the register map page to confirm that values other than 0x00 and 0xFF can be read from the device.</td>
</tr>
<tr>
<td>4</td>
<td>The GUI does not provide control for multiple SPI Chip Select outputs.</td>
<td>None. In multi-device SPI configurations the Chip Select signal from the AEVM would need to be manually moved to each PMIC individually.</td>
</tr>
<tr>
<td>5</td>
<td>USB Connections issues with COM ports associated with Bluetooth devices.</td>
<td>Disable or remove devices which enumerate as COM ports on the host pc.</td>
</tr>
<tr>
<td>6</td>
<td>Enumeration (connecting the USB cable to the AEVM) will attempt to connect to the device with the previous or default settings and may fail to connect.</td>
<td>Use the Device Settings and click the Connect to Hardware to update the GUI to the correct connection settings.</td>
</tr>
</tbody>
</table>

Revision History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

Changes from Revision * (December 2019) to Revision A (November 2020)

- Updated for release v2.0.0 throughout entire document

Page 3
IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS” AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you permission to use these resources only for development of an application that uses the TI products described in the resource. Other reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims, damages, costs, losses, and liabilities arising out of your use of these resources.

TI’s products are provided subject to TI’s Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable warranties or warranty disclaimers for TI products.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2020, Texas Instruments Incorporated